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Brief Overview of ArcGIS 

ArcGIS is a software program, used to create, display and analyze geospatial data, developed by Environmental Systems Research Institute (ESRI) of Redlands, California. ArcGIS consists of three components: ArcCatalog, ArcMap and ArcToolbox. ArcCatalog is used for browsing for maps and spatial data, exploring spatial data, viewing and creating metadata, and managing spatial data. ArcMap is used for visualizing spatial data, performing spatial analysis, and creating maps to show the results of your work. ArcToolbox is an interface for accessing the data conversion and analysis functions that come with ArcGIS. The ArcGIS software license comes in three variants: ArcView, ArcEditor, or ArcInfo, which are the low end, middle, and fully configured versions of the software. Any of these versions can be used for this exercise. The instructions in this exercise are illustrated using the tools in ArcGIS version 9.3.
Brief Overview of CUAHSI Hydrologic Information System
The Consortium of Universities for the Advancement of Hydrologic Science, Inc (CUAHSI), is an organization of which about 120 US universities are members, that is supported by the National Science Foundation (NSF) to develop infrastructure and services for the advancement of hydrologic science in the nation’s universities (http://www.cuahsi.org).   The CUAHSI Hydrologic Information System project (http://his.cuahsi.org) is separately funded by NSF to better support hydrologic science with information systems technology.  A critical class of water information is observations data measured at point locations on water properties such as gaged information on water flow, water levels, precipitation, evaporation and climatic variables, and sampled information on water quality and biology.   CUAHSI HIS has developed a set of web services to provide uniform access to this information in a specially designed internet language for water data called WaterML.  These web services can be accessed from any application program, including Excel,  ArcGIS, and Google Earth. 


Goals of the Exercise

This exercise introduces you to ArcMap and ArcCatalog. You use these applications to create a map of pan evaporation stations in Texas, and to draw a graph of monthly pan evaporation data measured at these stations. You use ArcCatalog to create a new personal geodatabase and import shapefiles to a feature dataset. The relationship between ArcGIS and MS Word and Excel is demonstrated so that you can create graphs in Excel, maps in ArcGIS and place the result in a Word file as a report for this homework. In this way, you link the spatial location of the observation sites, with the time variation of the water observations data at those sites.  This exercise also introduces you to HydroExcel and provides an example of downloading hydrologic observations data using web services from the CUAHSI Hydrologic Information System, then displaying the data in Excel and the observation sites in Google Earth.


Computer and Data Requirements

To carry out this exercise, you need to have a computer, which runs ArcGIS.   HydroExcel is a Microsoft Excel spreadsheet that uses macros and an underlying applications package called HydroObjects to download observations data from WaterOneFlow web services. HydroExcel is available on the CUAHSI HIS website (http://his.cuahsi.org/hydroexcel.html) and similarly HydroObjects http://his.cuahsi.org/hydroobjects.html . Download the spreadsheet (2003 or 2007 version, the labs have Office 2007) and open it in Excel.   You have to install HydroObjects prior to running HydroExcel.   HydroExcel invokes the Google Earth mapping system which you can obtain from http://earth.google.com/    All these programs have been downloaded and made accessible in the computer laboratories for this course (at the University of Texas, this is Room 3.400 in the Civil Engineering Learning Resource Center).
You will be working with the following spatial datasets during this exercise: 

1. A polygon shapefile of the counties of Texas, called Counties 

2. A point shapefile of pan evaporation stations, called Evap 

3. A polygon shapefile of the state of Texas, called Texas 

These shapefiles consist of several files (e.g. evap.dbf, evap.shp, evap.shx). You can get them from this zip file: Ex12008Data.zip. 
You need to establish a working folder to do the exercise on. This can be in c:\temp, your student directory, or on a memory stick attached to the machine you are working on. To establish a new account at the CE Learning Resource Center, go to http://www.ce.utexas.edu/lrc/ and select CE-LRC User Accounts. If you don't yet have a regular NT Login account at the LRC, get a temporary guest login to do the exercise.   
After you have downloaded the zip file ex12008.zip double click on the file and you should see the Winzip, Alladin Stuffit utility, or other zip utility to open the file on your computer (if it doesn’t open you’ll have to unzip this file on a computer that has a zip utility installed). Extract all files from the zip file to the working folder that you’ve set up to do this exercise. You should end up with a file list that looks something like this. You may see these data within a sequence of folder names, and if so, click on each folder down through the sequence until you locate the required files.
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ArcGIS License Server

This exercise can be executed with any of the license levels within ArcGIS, namely ArcInfo, ArcEditor or ArcView. Each of these license levels provides access to ArcMap and ArcCatalog, which are the ArcGIS interfaces used to do the work. When you invoke ArcMap or ArcCatalog, it is possible that you will get a message saying that all the licenses for ArcInfo are in use on the network, or that you aren’t licensed for this application. In that event, you need to switch to another license level of the software with available licenses. To do this, from Windows use Start/Programs/ArcGIS to invoke the ArcGIS Desktop Administrator, and select another version. In the LRC, ArcView [Single Use] works best, but in another lab setting, the ArcView [floating] or ArcEditor [floating] could be the right choice, depending on license availability.
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Procedure

Please note that the following procedure is a general outline, which can be followed to complete this lesson. However, you are encouraged to experiment with the program and to be creative. 

1. Viewing Shapefiles 

A shapefile is a homogenous collection of simple features that do not contain topological information. The format was introduced with ArcView 2.0 to simplify the representation of spatial data. A shapefile includes geometric features and their attributes. The attributes are contained in a dBase table, which allows for the joining with a feature based on the attribute key.

Viewing Shapefiles in ArcMap

(1) Open ArcMap and select the A new empty map option.
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(2) Use the [image: image5.png]


(Add Data) button to add the exercise data for this exercise. Navigate to the folder, which contains the data, and select all three files at once by using the shift key. Click the Add button to import the data. If you are using a network drive to obtain your files use the [image: image6.png]


 button to add the network drive to the ones that ArcMap is accessing so you can get to the files.
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In ArcMap, a layer consists of a reference to a spatial dataset (such as a feature class, shapefile or coverage) and a definition of how to display it (legend colors, line thickness, etc.), and a map is a graphical representation of geographic information. The left panel in the ArcMap window is the Table of contents, and the right panel is the Display window. In the middle is ArcToolbox, whose use we will cover later. Click this off so that you just have the Table of Contents and the Map Display panels displayed. The Table of contents lists layers, and the Display window displays maps. You may get a message that says that “one or more layers lacks spatial reference information and can’t be projected”. Don’t worry about this. The Texas polygon layer has a projection file (Texas.prj) and the other files are in the same coordinate system. We’ll deal more with projections in later exercises. As you can see it is very simple to add shapefiles to ArcMap.

(3) Click off the check marks next to the layer names in the left hand column. Click on the check box next to each layer name individually to view what features that layer contains.   You can drag the layers up and down in the layer display to alter the order in which they are viewed on the map.
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When you are done exploring the possibilities of ArcMap, exit the program. You do not need to save the file since you will be coming back to ArcMap later in the exercise.

Preview Shapefiles in ArcCatalog 

(4) Open ArcCatalog 
Arc Catalog is like a Windows Explorer for GIS files. It helps you to quickly explore what data you have.
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(5) On the left panel, search for the folder where the exercise data is located. 
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In ArcCatalog, you can toggle the right panel display between a file tree (Contents tab), a data view (Preview tab), and a metadata document (Metadata tab). 

(6) Highlight the layer for the Counties shapefile and click on the Preview tab in the right panel. First look at the Geography preview.
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You can see the layer represents the outline of Texas. The Preview option allows you to display the feature class table as well, by selecting Table instead of geography at the bottom of the panel. 
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If you click on the Metadata tab, you’ll see descriptive information about the Counties layer:
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Click on the other two data layers to preview them also.
2. Creating Geodatabases, Feature Datasets, and Feature Classes

A geodatabase is a relational database that stores geographic information. A relational database is a collection of tables logically associated with each other by common key attribute fields. A geodatabase can store geographic information because, besides storing a number or a string in an attribute field, tables in a geodatabase can also store geometric coordinates to define the shape and location of points, lines or polygons. Note that a single table can store only one type of spatial feature (point, line or polygon) and not a mixture of feature types. A personal geodatabase is a file with extension .mdb, which is the file extension used by Microsoft Access. 
A feature dataset is a collection of feature classes that share the same spatial reference. The spatial reference describes both the projection and spatial domain extent for a feature class in the geodatabase. Because the feature classes in a feature dataset share the same spatial reference, they can participate in topological relationships with each other such as in a geometric network. These topological relationships can also be stored in the feature dataset. Note that feature classes in a geodatabase can exist as stand-alone feature classes, without being part of any feature dataset.

A feature class is a collection of features with similar geometry. There are point, line, and polygon feature classes. Two types of feature classes exist: simple feature classes and topological feature classes. A simple feature class includes features that have no topological associations among them and features maybe edited independently of each other. Topological feature classes are bond as one integrated topological unit, such as a geometric network that we’ll explore later in this class.

Create a new Geodatabase 

(1) To create a new geodatabase in Arc Catalog first right click on the folder that contains the data for the exercise. Select New/Personal Geodatabase and a new geodatabase -- called New Personal Geodatabase.mdb and represented by an icon with the shape of a cylinder -- will be created. Note – a File Geodatabase is an alternative form that stores the data in a file system instead of as an Access file. It can be faster to do this but this is not important for this exercise.
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(2) Name the geodatabase Ex1Data (the geodatabase will keep its file extension mdb regardless of whether you included it in the name or not). You can right click on the geodatabase name and use Rename to rename the file.
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Adding Data to the Geodatabase 

When first loading data into a geodatabase, it is important to think about the data and how they are related. As mentioned above, in geodatabases the data is placed in feature classes that are then organized into feature datasets. A geodatabase can have one or more feature datasets. Each feature dataset has a single reference frame, which includes the map projection and map extent. It is possible to define the reference frame after the creation of the feature dataset and before data is loaded. 
Create a New Feature Dataset

We will create a new feature dataset within this geodatabase to define the spatial reference of our data. Right click on the Ex1Data.mdb geodatabase and select New Feature Dataset.
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Name the new feature dataset Texas, and hit Next to set the co
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and hit Next to set the coordinate system for these data.
Select [image: image18.png]Import.



 in this screen, and then select Texas.shp. 
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This has the effect of assigning the coordinate system of the Texas.shp theme to the Feature Dataset. 
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Click Add and then Next and you will be asked to select a vertical coordinate system
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In this case, we don’t have vertical coordinates (z-values) so we’ll just accept “none” and hit Next. You’ll now be asked to select tolerances for various coordinate systems. Just “accept the default resolution” and hit Finish. Note that this process of setting up a Feature Dataset in ArcGIS version 9.2 and 9.3 is significantly different than in earlier versions of ArcGIS and this avoids a problem of your being forced to set a spatial bound on the extent of your data that caused considerable difficulties in this class in previous years.
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Now you have a new feature dataset called Texas.  Don’t worry if you see a screen that says that Metadata has not been set for the selected item.
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And if you view the Spatial component of the Metadata for this Texas feature dataset, you’ll see that you are using NAD_1983_Albers projected coordinate system. 
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And if you click on details, you’ll see some more information about the parameters of this coordinate system. You’ll learn what this means in your lecture on map projections and coordinate systems!
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If you check the file list for the shape files that you opened at the beginning of this exercise, you’ll find that the Texas shape file is the only one that has a .prj file and the Counties and Evap shape files don’t have a .prj file, which means that they have a coordinate system but it is undocumented in your dataset. 
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If you open the Texas.prj file in MS Word, you’ll see the following information:

PROJCS["NAD_1983_Albers",GEOGCS["GCS_North_American_1983",DATUM["D_North_American_1983",SPHEROID["GRS_1980",6378137.0,298.257222101]],PRIMEM["Greenwich",0.0],UNIT["Degree",0.0174532925199433]],PROJECTION["Albers"],PARAMETER["False_Easting",1000000.0],PARAMETER["False_Northing",1000000.0],PARAMETER["Central_Meridian",-100.0],PARAMETER["Standard_Parallel_1",27.41666666666667],PARAMETER["Standard_Parallel_2",34.91666666666666],PARAMETER["Latitude_Of_Origin",31.16666666666667],UNIT["Meter",1.0]]

This information is what has been displayed in a more readable form in the metadata file that you’ve just looked at in ArcGIS.  Notice also in the list of files given below that you now have two Microsoft Access files in this list called Ex1Data, one which has 548KB and actually contains the data, and the other which is 1KB which is a “lock file” [image: image27.png]FEx1Data



 that exists while the ArcCatalog or ArcMap applications are open to prevent this file from being altered with another application while you are working on it in ArcGIS.

It happens that these shape files have the same coordinate system as the Texas shape file so when they are imported into the geodatabase, they overlay correctly in the same spatial reference. If you get shape files or coverages with undocumented coordinate systems, it can be a real headache to figure out what the correct coordinate system is. Fortunately, ArcGIS version 9 automatically documents the coordinate system on each shape file, but earlier versions of ArcView did not, and you may encounter the problem of undocumented coordinate systems when loading older shape file data.

To import the shape files into the feature dataset, right click on the Texas feature dataset and select Import Feature Class (single)
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You’ll see a Green Dot next to Input Features – browse for the shapefile Texas and click to import it. Type the name Texas into the Output Feature Class Name field: 
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Click Ok and a new feature dataset called Texas will be created within the Ex1Data geodatabase, and within that a new feature class called Texas will exist which contains the outline of the state of Texas.
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And if you view the Geography of this feature class in Arc Catalog, you’ll see:
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Ok, let’s continue with the exercise.

Import the other shape files for Counties and Evaporation to the feature dataset in a similar way that you just did for the Texas outline. You may see some messages in Green about the resolution of the output feature class being greater than for the input feature class. Don’t worry about this.
After creating the geodatabase, the feature dataset and the feature classes, the ArcCatalog tree looks like this: 

[image: image33.png]Ext
= Qe
3 extoata.nds
= 0 Tess
Countes
Hevep
Texas




Note that the feature classes Texas, Counties, and Evap could have been created outside the feature dataset Texas, but since they share the same coordinate system, it was decided to group them together within the feature dataset.   If you have data in other coordinate systems (defined with a .prj file) these will be automatically converted to the coordinate system of the feature dataset during the importing process.
3. Displaying Feature Datasets in a Map

We will now add the feature dataset that we created in ArcCatalog to an ArcMap document. 
(1) Close Arc Catalog.  You’ll see that the lock file has now gone away.   
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You can display data in ArcMap when ArcCatalog is open on the same data, but you cannot alter these data in any way.  

To display the spatial data of the Texas feature dataset in a map, now open ArcMap.  You can launch ArcMap from within ArcCatalog using  [image: image35.png]


 or you can open ArcMap from the Start menu as you did before. 
(2) In ArcMap, click on the Add Data button, [image: image36.png]


. 
Browse to the feature dataset Texas, 
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and click Add. This has the effect of adding all the feature classes in the feature dataset to the ArcMap display. You can add individual feature classes within the Texas feature dataset if you so desire, by clicking on the feature dataset icon, and then on the icons of one or more of the feature classes (Hold down Ctrl or Shift to select more than one feature class). 

Note that the Table of Contents lists the layers corresponding to the three feature classes of the Texas feature dataset that you just added, while the Display window displays the map with the corresponding spatial data (i.e., Texas counties and evaporation stations). When I loaded up my feature dataset, I found that the Texas outline map is plotted above my Counties so I can’t see my County boundaries. 
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This is fixed by dragging the Counties feature class up in the list of Layers so that it is above the Texas layer. The order in which the feature classes are displayed is the order they are listed in the Layers.
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(3) Save your work in ArcMap by choosing File/Save and, after navigating to your working directory, naming the file Ex1 (the file will be assigned the extension mxd). When you do this, the Ex1.mxd file contains the file location of the geodatabase and the symbology you’ve chosen for the map display. You can shut down Arc Map and then invoke Arc Map again and reload the same map display by clicking on Ex1.mxd. Note, however, that if in the mean time you’ve relocated your geodatabase, ArcMap will go back to where you had it at the time the map file was saved. 
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________________________________________________________________________
Helpful Tip:

If you open your ArcMap Ex1.mxd file later from another location in your file system, you may see a red exclamation points beside your feature classes. If this happens, in ArcMap, right click on the feature class use Data/Set Data Sources to relocate the file location where the corresponding data are now stored and your map will display correctly again. It does not matter where the Ex1.mxd file is stored, you can move that around wherever you want, but it does matter where the data referred to in that file are stored. ArcGIS 9.3 is a good deal cleverer at dealing with file locations than earlier versions were so you may not encounter this problem.
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Ok, let’s continue on with the exercise.

(4) To change the appearance of a map display, you can access the Symbology menu just by double clicking on the Symbol
 [image: image42.png]



displayed in the ArcMap Layers, and you’ll get the Symbol Selector window 
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Click on the symbol color box, make your selections for the Fill Color and the Outline Color, and click OK, twice. Follow this procedure to modify the display of the Counties layer. Hopefully, the new map looks better than the original one. You can show the outline of the State of Texas more distinctly by using the Hollow symbology for the Texas polygon and then changing the Outline Width to 2 or 3. Otherwise the Texas layer is obscured behind the Counties layer and you won’t see it.

More complicated symbol shading that has the color and size of the symbols varying according to attributes of a feature class can be manipulated by accessing the Properties of the Symbology of the Feature Class.
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4. Accessing and Querying Attribute Data
Numerical and text information stored in the fields of the geodatabase tables are called attributes. To access attribute data of the feature classes at a specific location:
(1) Click on the Identify Features tool [image: image45.png]


 which is contained within the “Tools” menu. If you don’t see this set of tools on your ArcMap document, use View/Toolbars and click on Tools to make it appear.

[image: image46.png]



(2) Click on the feature on the map you are interested in, and in the Identify Results window, select the object you are interested in. In the figure, attribute data for the Austin Airport evaporation station in Travis County has been retrieved (Travis County is where Austin and the University of Texas are located). I have used the Zoom button [image: image47.png]


 to zoom into the middle of the state where Travis County is located to create the next picture:
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If you inadvertently close the Tools menu you just used, you can open it again from the View menu (it is called Tools  in the tools menu): 
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Viewing an Attribute Table 

(3) Tables that contain attribute data of a layer are always called Attributes of <layer name>, and contain a field called Shape. The field Shape displays the words Point, Line or Polygon, but it really stores a geometric object with the shape of a point, line or polygon. To access attribute data of an entire layer, in ArcMap: right click on the Evap layer name in the table of contents, and select Open Attribute Table: 
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And if you scroll down and click on ObjectID 44 you’ll see the record that contains the attributes of the Austin Airport station that you identified earlier. Click on this to select it, and you’ll see the corresponding point selected in the map – this is a key idea of GIS – map features are described by records in attribute tables.   These are data measured by the Weather Service Office (WSO) at the Austin Airport (AP).
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 (4) To Clear a Selected feature and select a new one, use: Selection/Clear Selected Features in the ArcMap toolbar: 
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5. Selecting features from a feature class (points, lines and polygons)

Selecting features from a feature class involves choosing a subset of all the features in the class for a specific purpose. Feature selection can be made from a map by identifying the geometric shape or from an attribute table by identifying the record. Regardless of how you select an object, both the shape in the map and the record in the attribute table will be selected. To choose a particular data layer for selection use Selection/Set Selectable Layers and then click off the layers that you don’t want to have selected. Be careful when using this Set Selectable Layers function because if you later want to select features from another class, you’ll have to go back and change this selection to your new class.

[image: image53.png]Selection Took Window Help

Sy select by attiutes
& elect by Locaton

Interactive Selection Method >

Options,




[image: image54.png]I Set Selectable Layers

8k

Choase which layes can have thei fealures selected interactively vith the
Select Features tool, the Select By Graphics command, the Edt too, etc

O Evan Select Al

O Texas
Clear Al





(1) To select an object from the map, in ArcMap: click on the Select Features tool [image: image55.png]


, in the Tools menu

(2) Zoom to the full extent of the map, by using the [image: image56.png]


 button on the Tools menu. Click on the Counties polygons you want to select. To select more than one object, press the Shift key and hold it down while you click on the additional objects. Selected objects are displayed with a light blue outline, although the color might change depending on your settings. The corresponding attribute table records have also been selected. You can verify this by opening the Counties attribute table, and hit Selected at the bottom of the attribute table to show just the Selected Counties.
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(3) To clear your selection, right click on the layer name, and choose Selection/Clear Selected Features. 

6. Making a Chart

Charts are useful because they allow you to visualize trends in data. ArcMap has chart-making capabilities. We will plot a chart of one or more records selected from a geodatabase table. 

(1) Use Selection/Set Selectable layers to show only the Evap data layer. 
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Select the two evaporation points that are located in Travis County. Travis County is located in Central Texas and has a characteristic shape like a tooth! If you open the Evap attributes table and hit [image: image59.png]Selected



 you’ll see just the evaporation records for these two stations (one at the airport, and one at Mansfield dam which creates Lake Travis, a large lake near Austin). If you scroll across, you’ll see some attributes from January to December and an Annual value. These are monthly and annual average pan evaporation values in inches compiled from historical data measured at these locations.  Right click on Options at the bottom of the Attribute Table and select Create Graph.
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You can also get at this Chart menu from the ArcMap tools menu as shown below:
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(2) You will be making a Vertical bar chart (the default option). The next screen will allow you to indicate the data to be used in the graph. Here is a graph of the Annual Evaporation (Ann_Val) of the two stations plotted against a backdrop of all the stations in Texas, indexed using ObjectID:
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Hit Next and edit the graph properties to make them nicer.  Click off  [image: image63.png]¥ addta legend



 to get rid of the legend on the right hand side.   Use [image: image64.png]Color



 to customize the color display of your data.
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Press Finish. You have created a graph in ArcMap!!
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Save your ArcMap document Ex1.mxd so that you can retain this display.

Another graphing option is to make a chart in Excel using the dBase tables given by the evaporation shapefile. Open the evaporation attributes table evap.dbf as a table in Excel. Use Files of Type: dBase files in Excel to focus only on .dbf tables when you open the table. Select the stations you want to plot, copy their records to a new worksheet, delete the columns you don't need there, and then create a chart. Here is an example chart created this way. The column headers have been renamed from Jan_Val to Jan, etc to make the Chart x-axis more attractive to view. The legend has been moved to the top of the chart to allow a wider spacing of the data in the chart. I copied the data for Mansfield Dam and Austin airport into a new spreadsheet to make this chart.
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____________________________________________________________________________ 

Helpful Tip:

Instead of opening the evap.dbf file in Excel, you could have accessed the same data directly from the geodatabase using Data/Get External Data in Excel
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Choose MS Access Database as the data source. 
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Navigate to the geodatabase and select the table Evap. Then select the fields that you want to appear in the spreadsheet. You’ll end up with a spreadsheet containing the data for all the fields you’ve selected.
Ok, let’s continue with the exercise.

7. Creating a Map Layout

To consolidate a map of counties of Texas with evaporation stations with the graph that you created before in a single sheet of paper, in ArcMap: (1) change the format of the display window from Data View to Layout View by clicking on View/Layout View, 
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If your Layout doesn’t display properly in ArcMap, hit [image: image71.png]2n ]



 at the bottom of the map display to refresh it.
Reduce the size of the data frame in the layout (i.e., rectangle where the spatial data is contained) -- to make room for the graph -- by clicking on the graph and moving its handlers. If you have a zoomed in view in Arc Map, you’ll get the same image in in the Layout. To go back to the image of the whole State of Texas, right click on the Texas data layer in the legend and select Zoom to Layer. 
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To insert the ArcMap Chart into the Layout, right-click on the upper blue bar at the top of the Chart and select Add to Layout. Move and resize the graph as necessary. If you want to copy your graph from Excel, highlight the graph, and click on Copy on Excel, then Paste in ArcMap and your graph should appear in the map layout.
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You can draw lines to relate the location of the measurement stations and the data plotted on the graph using the Draw a Line tool from the ArcMap Draw toolbar (to display this Toolbar, use View/Toolbars and select Draw). This draw toolbar works the same in ArcMap as it does in other MS applications. It is important to show some association between the data plotted on the chart and where these data were measured on the map so that you can figure out which data series was measured at what location. 
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Or you can add text with the text tool [image: image76.png]


shown next to the line draw tool. The text displays in very small font sizes.  Select and click on them to resize them.  You can also insert a North Arrow and a Scale Bar by using the Insert menu in ArcMap.   
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When you put up the scale bar it is in meters because those are the map units used in the data.  If you click on the scale bar you can redefine the distance units (I have used miles) and if you expand or contract the scale bar you can show a desired spacing of these distance units.

Your map might look like this:
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You can export your map from ArcGIS using File/Export Map from the ArcMap menu, and you can store this as Ex1.emf in your data file. Then you can add it to a Word document using Import/Picture/From File and load this emf file, as shown below. Pretty cool!
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Here's another option: suppose you want to take a chart in Excel and add a map to the Chart to show where the data apply.   In the Map display (not Layout Display) use File/Export Map to create another .emf file, and then in Excel you can use Insert/Picture from File to place this in an Excel graph.  You can see that in this map, a nice color association between the symbols on the map and the bars on the chart makes it clear which data series was measured at which location. This chart shows a different pair of evaporation stations that are color code at their geographic locations so you can see how the pattern of evaporation varies geographically.
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The manipulations just described transfer objects from one application to another. 
___________________________________________________________________________

Helpful Tip:

A more general procedure is to simply copy the screen to the clipboard and crop out the part that you want, saving it to a file for later use. That is how all the images in this exercise were prepared. To copy any image, hit Print Screen on your keyboard (this copies the Screen onto the Clipboard). If you only want to capture the active frame, press Alt + Print Screen. This is convenient if you only want to capture an attribute table or graph within ArcMap as opposed to the entire screen, therefore no cropping is necessary.
The image copied from the screen can be pasted directly into word then edited using the Format tab. Double click the pasted image to automatically open the Format tab. The Crop function allows you to trim out the unwanted portions of the image.
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‘The manipulations just described transfer objects from one application to another.

Helpful Tip:

A more general procedure is to simply copy the sereen to the clipboard and crop out the part that you want, saving it to a file for later use. That is how all the images in this exercise were
‘prepared. To copy any image, hit Print Screen on your keyboard (this copies the Screen onto the Clipboard). If you only want to capture the active frame, press Alf + Print Screen. This is
convenient if you only want to capture an attribute table or graph within ArcMap as opposed to the entire screen, therefore no cropping is necessary.

The image copied from the screen can be pasted directly into word then edited using the Format tab.

Ok, let's continue with the exercise.
To be turned in: An ArcMap map layout in it showing a map of Texas with gages, and linked with a graph showing monihly evaporation data plotted from one or two gages.
8. Learn about Google Earth

An addendum to this exercise that explores the how to use the same data as in this exercise in the context of Google Earth is available at
http://www.ce.utexas.edu/prof/maidment/giswr2006/Ex1/Ex12006Google.doc

These materials may be used for research and educational purposes only. Please credit the authors and the
Center for Research in Water Resources at The University of Texas at Austin.
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___________________________________________________________________________

Ok, let’s continue with the exercise.

In the presentation of information on maps and charts it is important to include sufficient labeling detail so that the information can be clearly and unambiguously interpreted.  You should include a scale bar to indicate distance, a north arrow to indicate direction and labels or legends with units wherever they are needed to interpret map or quantitative values.  

1. To be turned in: An ArcMap map layout in it showing a map of Texas with gages, and linked with a graph showing monthly evaporation data plotted from two gages.  Lets see some nice cartography!!
8. Using HydroExcel
Now you will learn how to use the HydroExcel spreadsheet to download hydrologic observations data and display it in Google Earth. First things first – you will need to make sure HydroObjects and Google Earth are installed on the computer you are working on. The machines in the computer lab should have this done, but if you are working on your own computer at home, there are instructions for installing HydroObjects in an appendix at the end of this document.   HydroExcel and HydroObjects are created by Dr Timothy L. Whiteaker at the Center for Research in Water Resources of the University of Texas at Austin.  If you have suggestions as to how improvements can be made to these application, please contact Dr Whiteaker at twhit@mail.utexas.edu   We are constantly working to improve the tools in our CUAHSI Hydrologic Information System project and your input is welcome.  You can get a clean copy of HydroExcel at http://his.cuahsi.org/hydroexcel.html  if necessary.
HydroExcel uses Excel VBA macros, so you will have to enable macros for HydroExcel to work. In Office 2007, a security warning will appear alerting you of the fact that macros have been disabled. 
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for the following dialog box, then select ‘Enable this content’. 
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If the warning does not appear, chances are that macros are already enabled. If the spreadsheet does not work, make sure macros are enabled by following the instructions below.

In the [image: image84.png]


 menu in Excel, Click on [image: image85.png]Excel Options



 at the bottom of the screen, go to the [image: image86.png]Trust Center



 and then choose [image: image87.png]Trust Center Settings,



 From this menu you will be able to enable all macros.
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Once you have made sure HydroObjects is installed, downloaded HydroExcel, and enabled macros, you are ready to roll! Let’s take a quick tour of the HydroExcel worksheet. HydroExcel has several worksheets for working with different aspects of WaterOneFlow data. The first is the introduction worksheet which provides useful instructions for using HydroExcel.
[image: image89.emf]
The next tab is the Data Source tab. Below is a screen capture of the data sources tab with some commentary on its different aspects.

[image: image90.emf]
Now you will select a data source using the data source tab. In this exercise we will be examining data from the Little Bear River web service which is operated by Utah State University. Begin by copying and pasting the web service definition language (WSDL) location for the first Utah State University WSDL, Little Bear River, into the WSDL location field, indicated as the Active Web Service above, at the top of the worksheet. 
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Now click ‘Get Sites’. The spread sheet will automatically switch to the Sites tab and populate the worksheet with 12 Little Bear River sites. 
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You will notice the Get Sites Options field at the top of the worksheet. The option to Show sites in Google Earth after download is set to the default FALSE. You can change this to TRUE by clicking in the False field, which causes drop down menu arrow to appear on the right side of this field. 
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Change this to TRUE then click Get Sites again. HydroExcel will download all the Little Bear River sites again and will also automatically open Google Earth and zoom to the 12 listed sites. Amazing! HydroExcel automatically generates a kml (keyhole markup language) file containing all the information in the HydroExcel, which is then read by Google Earth. 
Let’s take a look at what is going on in Google Earth.

You will see a number of yellow push pins on the map. If you zoom out some, you will begin to see that the push pins are all located in northern Utah and the Great Salt Lake is to the south west (shown in the red circle in the map below).
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Now zoom back into the push pins and click on one. You will see a dialog box pop up with some information, including, but not limited to, site code and name, network, latitude and longitude.
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Now, take a look at the Places pane on the left in Google Earth. You will see there is an entry called Little Bear River Sites within that a Little Bear River network in the Temporary Places folder. You can expand the Little Bear River network folder to view all the sites in the Little Bear River network. 

[image: image96.png]= Google Earth
Fie Edt View Tools Add Hep

fy® | Faasusnesses | orectons |

Fiyto e g, 1600 Pennsyivania Av

Mehurdy H

" e Vi, P,
10103 00.!“' = s 2 £
LR
1 > i

2008 172





Click on some of the various sites to view their location and the information about them. 
Close Google Earth and do not save the sites stored in Temporary places.

Now, we are interested in Little Bear River at Mendon road and want to know exactly which variables are measured there. Let’s return to HydroExcel to do that. 

In the Sites tab of HydroExcel, copy the site code for Little Bear River at Mendon Road and then click on the Site Info tab. Paste the site code for Little Bear River at Mendon Road (or type it manually) in the Site Code field at the top and change the ‘Show site in Google Earth after download’ to TRUE. 
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Value Count Start Date. End Date. Variable Name

48628 B/4/200511:30  5/23/2008 9:00 Battery voltage
48628 B/4/200511:30  5/23/2008 9:00 Turbidity
48628 B/4/200511:30  5/23/2008 9:00 Turbidity
48628 B/4/200511:30  5/23/2008 9:00 Turbidity
48628 B/4/200511:30  5/23/2008 9:00 Turbidity
48628 B/4/200511:30  5/23/2008 9:00 Turbidity
48628 8/4/200511:30  5/23/2008 9:00 Turbidity
48627 8/4/2005 11:30  5/23/2008 9:00 Temperature
36626 B/4/200511:30  8/16/2007 13:30 Gage height
36626 B/4/200511:30  8/16/2007 13:30 Gage height
48628 B/4/200511:30  5/23/2008 9:00 Gage height
13102 8/16/2007 1630 6/23/2008 9:00 Oxygen, dissohved
13102 8/16/2007 16:30  6/23/2008 9:00 Oxygen, dissolved pe
13102 8/16/2007 1630 6/23/2008 9:00 Specific conductanc
13102 8/16/2007 16:30  6/23/2008 9:00 pH, unfiltered
13102 8/16/2007 1630  6/23/2008 9:00 Temperature
13102 8/16/2007 1630 6/23/2008 9:00 Turbidity
29 10/4/200712:00  4/14/2008 12:30 Phosphorus, total as|
141 4/27/200520.00  6/7/2007 14:20 Phosphorus, total as|
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146 4/27/200520.00  6/7/2007 14:20 Solids, total Suspend
29 10/4/200712:00  5/7/2008 11:00 Solids, total Suspend
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Now click Get Site Info to view the site info for Little Bear River at Mendon Road. Again, Google Earth will automatically open (if it was not already) and zoom to the selected site. You will see that a new entry called Little Bear River: USU-LBR-Mendon has been created in the Places menu. When you expand this you will see there is only one entry, USU-LBR-Mendon. 
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Click on the one entry or on the new pushpin to see details about the site. A much larger call out box appears this time. Scroll through this and take a look at the information provided. You will find the same information as was displayed for the sites info query as well as time series information. This includes which variables are measured at this site and metadata about the time series. 
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Close Google Earth and do not save the sites stored in Temporary places.
We can also use Google Earth to visualize which variables are measured through time. Switch to the Site Catalog tab in HydroExcel
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40 LittleBearRiver-USU-LBR Paradise Little Bear River at McMurdy Hollo Utah Cache 4157
4 LittleBearRiver-USU-LBR Paradise Little Bear River at McMurdy Hollo Utah Cache 4157
42 LittleBearRiver-USU-LBR Paradise Little Bear River at McMurdy Hollo Utah Cache 4157
43 LittleBearRiver-USU-LBR Paradise Little Bear River at McMurdy Hollo Utah




Change the Show sites in Google Earth field to TRUE as before and hit Get Site Catalog. A new KML file will be generated and automatically displayed in Google Earth. Maximize the Google Earth Window. You will notice a new instance has been created in the Temporary Places folder called LittleBearRiver Site Catalog. Now you have two subdirectories in this folder, All Sites and Sites by Variable.
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Expand the All Sites folder, and the LitteBearRiver network will appear with all the Little Bear River sites as before. Click on one of the sites and the callout box will appear containing all the information that was displayed when we used the Get Site Info button.
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Now, collapse the All Sites folder and expand the Sites by Variable folder. Turn this layer on by checking the box next to its name and turn the All Sites layer off by un-checking the box next to its name.
Whoa, only one push-pin is visible now! This is because Google Earth has added a time dimension to the displayed data and only sites with variables measured at the point in time indicated by the time slider are displayed. Notice that a time slider has been added to the map display in the top right corner. The time slider should appear automatically, but if it does not it can be turned off and on using the View menu. 
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Press play, the larger arrow to the right of the time slider, [image: image105.png]


 to see what happens. As the time slider moves to the right the numbers below it change and more yellow pushpins appear. The number below the time slider is the day of the month and the year. 

By default all the variables are turned on, as indicated by the check mark next to the variable name, therefore the animation you just viewed shows when any variable is being measured at a site.
Say we are interested in Water Temperature only. Uncheck all the boxes but Water Temperature. By pressing the play button, we can easily see which sites measure Water Temperature during which periods. By expanding the Water Temperature folder, we see a subdirectory called LBR:USU36, this is the variable code for Water Temperature. By further expanding this subdirectory we see a list of sites. These are the sites at which Water Temperature is measured.
In HydroExcel, go to the Time Series tab and fill in “Get Values Options as shown below.  This will get you the observed data for water temperature for August 2008.
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These data can be copied to another spreadsheet and plotted, as below.
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To be turned in: Prepare a map and chart combination showing the location of the observation site on the Little Bear River at Mendon Road and a chart of the turbidity (variable USU4)measured there during August 2008.   Tip: Use Shift-Print Screen to copy the Google Earth display to your clipboard, then open the Paint program under “Accessories” in your Windows Menu and use the tools there to select the part of the Google Earth image that you want in your map.
9. Learn more about Google Earth
An addendum to this exercise that explores the how to use the data from first part of the exercise in the context of Google Earth is available at http://www.ce.utexas.edu/prof/maidment/giswr2006/Ex1/Ex12006Google.doc 
Summary of items to be turned in:

2. An ArcMap map layout in it showing a map of Texas with gages, and linked with a graph showing monthly evaporation data plotted from two gages.  Lets see some nice cartography!!
3. To be turned in: Prepare a map and chart combination showing the location of the observation site on the Little Bear River at Mendon Road and a chart of the turbidity (variable USU4)measured there during August 2008.   Tip: Use Shift-Print Screen to copy the Google Earth display to your clipboard, then open the Paint program under “Accessories” in your Windows Menu and use the tools there to select the part of the Google Earth image that you want in your map.
Appendix

Installing HydroObjects
The HydroObjects installation file and Users Manual are available on the CUAHSI Website at the following address: http://his.cuahsi.org/hydroobjects.html. 
Install HydroObjects using the following steps:

1. First, ensure that you have installed the Microsoft .Net Framework Version 2.0. If you do not have this installed on your machine, instructions for downloading and installing the .Net Framework Version 2.0 can be obtained from the Microsoft website via the following URL: http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB‐4362‐4B0D‐8EDDAB15C5E04F5&displaylang=en
2. Double click on the setup.exe installation file. This will begin the installation of HydroObjects. After a few moments, the following window will appear:
[image: image108.emf]
3. Click Next to continue with the installation. You will see the following window:
[image: image109.emf]
4. Read the license and then click on the radio button next to “I Agree” to accept the license. Click Next to continue. The following window will appear:
[image: image110.emf]
5. Choose where to install HydroObjects, and for whom to install HydroObjects, and click Next. The following window will appear:
[image: image111.emf]
6. Click Next to start the installation. As installation progresses, you will see a progress bar.
[image: image112.emf]
7. When installation has completed, click Close.
8. [image: image113.emf]
9. When installation has finished, view documentation or an example application by clicking Start, All Programs, CUAHSI HIS, HydroObjects. 


These materials may be used for research and educational purposes only. Please credit the authors and the Center for Research in Water Resources at The University of Texas at Austin.
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